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SHARED CONTENT

Shared content (sometimes called synchronized content) is any box, line, text story, or picture
that 1s designated to remain “in synch” across multiple layouts within the same project, or
even among multiple boxes within the same layout. (I discuss projects and layouts in
Chapter 4, Building a Layout.) When synchronized content is changed in one place, it automat-
ically changes in every other place that it appears. In XPress 6, you could only synchronize
the text in a box, but version 7 also lets you synchronize pictures, as well as the boxes. You
can synchronize the attributes of boxes, as well as the content and attributes of the pictures
or text within boxes.

For example, let’s say you synchronize the addresses in three layouts in a project: a letterhead,
an envelope, and a business card. Then when you change the address in the letterhead, the
address also changes in the other two layouts.

Or, you might want to have all the picture boxes in a layout share a consistent shape, size, and
border style. You can synchronize the box attributes and use the shared box throughout
your layout while displaying a different picture in each box. As you tweak the formatting
of one of the boxes, all the other boxes throughout the layout update automatically, which
makes it easier to maintain stylistic consistency.

Since XPress 7 supports both print and Web layouts in a project, you can even share content
between both print and Web pages.

The beauty of synchronized content is that it makes it simple to keep words, pictures, and
many of the stylistic attributes of boxes or lines in harmony throughout a project.

Synchronizing content is like storing text in a library (see more on libraries in Chapter 3,
Working with Items). You first have to create one instance of the picture or text and add it to
the Shared Content palette; then you can drag it out of the palette for each instance where
you want the item (see Figure 13-1).
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Figure 13-1
Shared Content palette
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Synching and Unsynching Content

Before you can use synchronized boxes or their content, you have to add a box to the
Shared Content palette (select Show Shared Content from the Window menu to open the
palette). Select any box or line and click the New button on the palette. (You can also
choose Share from the Item menu or the context menu). XPress prompts you for an item
name; you can use any unique name because this text appears only in the palette, as a label
representing the item. XPress also asks you if you want to synchronize the box attributes,
the content and its attributes, or the content only. Turn on the Synchronize Box Attributes
checkbox if you want to synchronize box formatting like size, color, and frames properties.
Turn on the Synchronize Content checkbox if you want to synchronize the picture or text
within the box. The Content & Attributes option synchronizes text and pictures along with
their formatting, or you can choose to synchronize Content Only (see Figure 13-2).
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Shared Item Properties

Note that if you synchronize a text box’s content without also synchronizing its attributes,
only the text (the actual letters, numbers, and symbols) is synchronized. The text formatting
is not synchronized. When you first synchronize text, it copies the formatting of the original,
but you can reformat the text in each text box for a different look, and it’ll still remain syn-
chronized. For instance, you might want some text to appear in one font and size on a
brochure (print layout) but in a totally different font and size in a Web page (Web layout).

Pictures behave similarly. If you synchronize a picture without also synchronizing its attrib-
utes, properties like picture eftects or scaling will not be synchronized, but the image will be.

When you click OK, the label name appears in the middle section of the palette as a new entry.
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You can store many synchronized items within the same project. The Shared Content
palette displays a label name for each item and also displays an icon for each type of content
shared, as well as the type of synchronization for each synchronized item.

Inserting synchronized items. Once you've got an item in the Shared Content palette,
you can use it in another place in your layout simply by dragging and dropping the label
name onto the layout. XPress then creates a new item on the page for you, along with any
content that is synchronized with the box. You can identify boxes or paths that are synchro-
nized or have synchronized content because their handles look like they’ve been electrified
(they have little lightning bolts in them).

Inserting text and pictures. If you have a text story in the Shared Content palette, you
can use it in another text box by clicking an insertion point in any text box or text path on
any layout in the same project, selecting a label name in the Shared Content palette, and
clicking the Insert button. Similarly, you can simply drag and drop the label name over the
box or path. Now the text is “synched.” If you’ve already got text in the box or path, XPress
asks if you’re sure you want to replace the contents. (Synchronized text has to be the only
thing in a text box or text path.)

Using a synchronized picture is just as easy. You can use a synchronized picture in a pic-
ture box by clicking any picture box on any layout in the same project, selecting a picture
label name in the Shared Content palette, and clicking the Insert button. If you prefer, you
can drag and drop the label name onto the box to place the synchronized picture in the
box. If you’ve already got a picture in the box, XPress asks if you're sure you want to
replace the contents.

Editing shared content. When you need to change synchronized content, just select it
in any of the boxes or paths where it’s used and edit it as usual. (There is no “master” box;
any synchronized box will do.) It changes immediately in all of its instances—even several
times on the same page if you’ve used it more than once.

Adding content for sharing. You can put text in a synchronized text story even if the
story is not used anywhere in your layout. For example, you might have standard legal text
that you use in every project. You can import new content directly into a synchronized
story in the Shared Content palette even before you’re ready to use it; it will be available
at your fingertips when you need it.

To do so, select the label name of the shared story (not the shared text box) in the Shared
Content palette and click the Browse button. (You can also choose Browse from the context
menu, select Import Text from the File menu, or use the keyboard shortcut Command/Ctrl-E.)
When the Import Text dialog box appears, select one of the files listed, then click the Open
button. The imported text will replace the text originally in your shared text story.
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Similarly, you can import pictures into synchronized pictures that aren’t used in the layout
by selecting the label name of a synchronized picture (not a picture item) in the Shared
Content palette and clicking the Browse button. (Once again, you can choose Browse
from the context menu, select Import Picture from the File menu, or use the keyboard
shortcut Command/Ctrl-E.) When the Import Picture dialog box appears, select one of the
picture files, then click the Open button.

Tip: Store “Boilerplate” Text. You can store text in a project even if you don't intend to use it right
away. You may know that certain blocks of text will be used in each of the layouts of a project. Place
your text in a dummy text box and synchronize it in the Shared Content palette. Then delete the
text box, and the label remains in the palette, ready for inserting into your layouts as you need it.

Editing the text label. Unlike with libraries, XPress does not display a thumbnail of any of
the items in the Shared Content palette, so it’s helpful to give synchronized items meaningtul
names to help you find what you’re looking for. You can edit the name of the synchronized
content label at any time. Simply select the label name on the Shared Content palette, and
either click the Edit button or choose Edit from the context menu. When the Shared Item
Properties dialog box appears, type a new name and click OK. Alternately, you can double-
click on the label to edit the name.

Unsynchronizing content. Sometimes you might need to “unsynch” either one instance
or all the instances of shared content. For example, if you’ve synchronized addresses in all
your layouts, but the address for the business card has to be listed in a more condensed way.
Since all synched text blocks must share exactly the same content, you’ll have to unsynchro-
nize that box on the business card layout; the other instances remain synchronized. To do
this, select the box or text path with the Content tool. Then choose Unsynchronize from the
Style menu or the context menu.

If you want to unsynchronize all instances of a synchronized item, select the label name in
the Shared Content palette and then either click the Unsynchronize All button or choose
Unsynchronize All from the context menu. The synchronized item remains in the palette
(in case you want to use it again), but all the instances of the formerly “synched” item can now
be edited independently. (If you need to resynchronize text or pictures, just drag the label
name over one or more boxes. Unfortunately, you can’t resynchronize boxes and lines.)

Deleting shared content. Synchronized content remains saved in the Shared Content
palette, whether it’s used or not, until you remove it. To remove a synchronized item from
the project, select its label name and click the Delete button (or choose Delete from the
context menu). This removes the label from the palette and unsynchronizes all instances
of the formerly synchronized item, so you can now edit them independently.
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Limitations of Synchronizing

While you’ll find many useful ways to use the synchronizing feature, you should also be
aware of its limitations. The shared content feature always includes all the text in the text box.
You can’t include just part of it. Each instance of the text (the actual letters, numbers, and
symbols) must be exactly the same. You can’t use the Stretch Picture to Fit Box, Scale Picture
to Box, or Fit Box to Picture features with synchronized pictures. Tables can’t be synchronized,
but table cells can be. Items and their content on a master page can’t be synchronized, nor
can text with anchored items. There is also no way to synchronize text between different
projects (all the layouts that use the text must exist within the same project). Luckily, you can
synchronize content between difterent projects with a new feature called Composition Zones.

COMPOSITION ZONES

Synchronizing boxes and their content is a great way to ensure consistency throughout a
project, but what do you do when you want to reuse something more complex than a single
box, story, or line? What if you want to reuse an entire layout? Quark’s answer is a new
feature in XPress 7 called the Composition Zone, which lets you share a layout or portion
of a layout and use it on a different page, in a different layout, or even in a completely dif-
ferent project.

This can be a great time-saver if you have complex “sublayouts” such as advertisements that
you want to use in different projects. With Composition Zones, you can easily use the
advertisement layout in other layouts, and when you make changes to the advertisement,
it will update automatically everywhere you’ve used it.

A Composition Zone is very similar to other kinds of shared content in XPress. It’s really
just a shared, synchronized layout within a new kind of XPress box. While Composition
Zones are new in XPress 7, the layouts that you display in them don’t have to be. You can
share and use any layout in a Composition Zone in another layout, even if it was created
using an earlier version. What makes Composition Zones especially powerful is that you
can share them with other XPress users.

Composition Zones let multiple people work on different parts of the same page at the
same time, so you can develop a collaborative workflow with other XPress users. When
you export a Composition Zone for someone else to work on, your layout updates auto-
matically as the other person makes changes to the Composition Zone.
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Let’s say you’re laying out a brochure that includes an order form. You can create a
Composition Zone that contains the form and export it as a separate file for others to work
on. They can open the exported layout and work in it as they would any other layout while
you continue to work on the rest of the brochure. When they save their changes, the

changes will appear in your project automatically.

Two elements make up a Composition Zone: a Composition layout and a Composition Zone
item, which is a type of box new in XPress 7. The easiest way to create a Composition Zone
is to select the items that you want to share and then select Create from the Composition
Zones submenu (under the Item menu or the context menu; see Figure 13-3). XPress will
remove the selected items from the page and replace them with a Composition Zone item
that links to a new, hidden layout in your project. All the items you had selected will be
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Figure 13-3
Creating a Composition Zone

name in the middle of the box (see Figure 13-4).
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Another way to make a Composition Zone is to use the Composition Zones tool. When
you draw a box the size you want, XPress creates a new Composition Zone and links it to
a new, hidden Composition layout. When you make a Composition Zone using the
Composition Zones tool, your new layout will not contain any items.

Editing Composition Zones

It may initially seem strange that you can’t edit Composition Zones on the page, but it
makes sense, if you think about it. A Composition Zone contains a layout, which you edit
in its own window or tab just like you would any other layout. The trick is to find the
Composition layout.

When you want to make changes to a Composition layout, click the Composition Zone item
on the page and select Edit from the Composition Zones submenu (under the Item menu or
the context menu). XPress opens a new window with your Composition layout in it. It should
look familiar—it’s a layout like any other, with all the features and functionality of a regular
layout, so you can do anything you would normally do in any other layout. When you’ve
finished editing, just close the window and you’ll see that the Composition Zone item has
changed. XPress automatically updates the Composition Zone everywhere it is used.

Tip: Watch Live Updates. You can edit a Composition Zone and then arrange the two windows
to see the changes take place in real time.

Editing a Composition Zone item. While you’re working on the Composition layout
inside a Composition Zone, it can be easy to overlook that a Composition Zone is also an
item itself. That means you can use the Measurements palette or the Modify dialog box to
assign properties that don’t apply to normal layouts, such as location, frame characteristics,
and runaround. The changes you make inside a Composition layout will be reflected in
every instance of the Composition Zone, but the Composition Zone item can be edited
independently.

Assigning certain item properties to a Composition Zone might produce unexpected
results, though. For example, you can apply a difterent background color to each instance
of a Composition Zone, which could be confusing. Also, applying a drop shadow to a
Composition Zone item applies the shadow to all the objects in the zone rather than to
only the item itself. I hope Quark fixes that in a future revision.
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Sharing Composition Zones

Since the purpose of a Composition Zone is to share it for reuse, it would make sense for
a Composition layout to be shared by default, but you do need to take one more step
before you can share it. Click on the Composition Zone and select Share from the Item
menu or the context menu. When the Shared Item Properties dialog box appears (see
Figure 13-5), you can control where a Composition Zone can be used and seen. Select All
Projects from the Availability popup menu to share the Composition Zone with others or
use it in other projects.

Shared Item Properties

Mame: Composition Zone

Availability: | This Project Only | :J
Location: Internal Make External...

E Show Tab in Project Window

{ cancel ) 0D Figure 13-5
Sharing a Composition Zone

Remember that XPress makes a hidden Composition layout when you create a Composition
Zone in a project. That’s great if you don’t want to deal with the clutter of multiple layouts
in a project, but it can slow you down if you want to make a quick change to a shared layout
and you have to find it when you’re somewhere in the middle of a long project. Fortunately,
you can make a Composition Zone display a tab at the bottom of the XPress project window,
just like any other layout, by turning on Show Tab in Project Window. The Composition
Zone will appear as its own layout at the bottom of the XPress project window.

External Composition Zones. When you enable sharing, you can make a Composition
Zone available for use on another page, in another layout, or in another project. But by
default, a Composition layout is hidden. If you’re going to use it in another project or share
it with someone else, you want to make it easy to locate. Click the Make External button
to make the Composition layout its own project, which makes it easier to find and share
with others. When XPress displays the Save As dialog box, type in a file name (or edit the
one that’s there), then click the Save button to save it to disk.

On the other hand, if you already have an external Composition layout and you don’t want
to keep track of multiple files, click Make Internal. XPress will import a copy of the shared
layout into a new Composition layout and break the link with the external file.
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When you’ve made all the changes you want to make to the Shared Item Properties, click
OK and the Composition Zone will appear in the Shared Content palette (see Figure 13-6).
Just like other kinds of shared content, a shared Composition Zone’s handles look like
they’ve been electrified (they also have little lightning bolts in them).
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Synchronization: Content Composition Zones
are shared content.

Tip: Share All Your Layouts. You can share any layout as a Composition layout. Select Advanced
Layout Properties from the Layout menu and turn on the Share Layout checkbox.

Placing a Composition Zone. Once you've got a Composition Zone in the Shared
Content palette, you can use it in another place in your layout simply by dragging and drop-
ping the label name onto the layout. XPress creates a new item on the page for you, along
with a preview of the first page of the shared layout in the Composition Zone. Remember
that you can put any shared layout into a Composition Zone, even if it was created using
an carlier version of XPress or if it contains multiple pages. For example, you might have
a layout that contains three versions of an ad, each on its own page. You could use a single
shared layout but display different versions of the ad on different pages of the layout.

If your shared layout contains multiple pages, XPress displays the first page in the
Composition Zone. To display a different page, select Modify from the Item menu
(Command/Ctrl-M) to display the Modify dialog box. Click the Layout tab, then type the
page number you want in the Page field or choose it from the Page popup menu. If you're
using multiple instances of a Composition Zone, you can display a different page of the
Composition Zone in each place you use it.

Linking to external Composition layouts. When you want to use a Composition layout
from a different project or one that another person has shared with you, you have to link
to an external project that contains a shared layout.
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You can link to external layouts in the Collaboration Setup dialog box.
1. Choose Collaboration Setup from the File menu to open the dialog box.
2. In the Linked Layouts tab, click the Link Layout button.

3. When the Link Layout dialog box appears, browse the file system and find the file
you’re looking for, then click the Open button. The names of all the shared layouts
in the linked project will display in the middle section of the Linked Layouts tab (see
Figure 13-7). After you click Done to close the dialog box, each newly linked layout
will appear in the Shared Content palette as a new Composition Zone, ready to be
placed in your layout.

Collaboration Setup

[ Job Jacket | Linked Layouts | Shared Layouts = Content = Updates )

MName Original Name Layout Type
External Compaosition Zone External Compaosition Zone Print
(' Link Layout... ) Break Link Remove

Figure 13-7 Linking to an external Composition layout

Editing the text label. Like you do with other types of shared content, it’s helpful to give
Composition Zones meaningful names so you can easily identify the one you’re looking
for in the Shared Content palette. You can edit the name of the Composition Zone label
at any time. Simply select the label name on the Shared Content palette, and either click
the Edit button or choose Edit from the context menu. When the Shared Item Properties
dialog box appears, type a new name and click OK. Alternately, you can double-click on
the label to edit the name.

If'a Composition layout’s tab is showing in the layout window, you should know that the
name displayed on the Composition Zone item is not the name displayed on the tab in the
project window. The name displayed on the Composition Zone is the name displayed in
the Shared Content palette. Changing the name of the layout in the Layout Properties
changes the name displayed on the layout tab, but it doesn’t change the name of the
Composition Zone item or its label in the Shared Content palette. It would make more
sense if the names in the Layout Properties and the Shared Item Properties were synchro-
nized. Again, I hope Quark fixes that in a future update.
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Removing Composition Zones

If you want to make a change to one Composition Zone without changing any of the other
places it’s used, you’ll have to “unsynch” that Composition Zone from the shared content.
To do this, select the item with the item tool. Then choose Unsynchronize from the Item
or the context menu. XPress will duplicate the Composition Zone and create another hidden
layout that is not shared; the other instances remain synchronized.

If you want to unsynchronize all instances of a Composition Zone, select its label name in
the Shared Content palette and then either click the Unsynchronize All button or choose
Unsynchronize All from the context menu. The Composition Zone remains in the
palette, but all the instances of the zone item in the layout can now be edited indepen-
dently. When you unsynchronize a Composition Zone, it remains its own layout, which
can be a limitation, as I discuss below.

Sometimes, though, you might want to unsynchronize a Composition Zone without making
it editable at all. For example, you might have a shared layout that you use in many projects
but don’t want anyone to be able to make changes when you share it with others. To unsyn-
chronize a Composition Zone and make it ineditable, select Convert to Picture from the
Composition Zones submenu from the Item menu or the context menu. XPress saves the
page displayed in the Composition Zone as an EPS, places the EPS file in the same folder
as the current project, converts the Composition Zone into a picture box, and then imports
the EPS into the new box.

Deleting a Composition Zone. Composition Zones remain saved in the Shared Content
palette, whether or not they’re used, until you remove them. To remove a Composition
Zone from the project, select its label name and click the Delete button (or choose Delete
from the context menu). This removes the label from the palette and unsynchronizes all
instances of the formerly synchronized item, so you can now edit them independently.

If the Composition Zone was external, the saved file remains in the file system and can be
used in other projects.

Limitations of Composition Zones

Unfortunately, once you’ve created a Composition Zone, you can’t “uncreate” it or
decompose it into its component items on the original layout. If you start creating
Composition Zones indiscriminately, you may find yourself with a lot of little layouts
within layouts, which could become confusing and potentially make your file much larger
than it should be. Also, you can’t show a Composition layout’s tab in the project window
if the Composition Zone isn’t shared.
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Another shortcoming of Composition Zones is that they can’t be resized in a layout. You
can change the page size in the Layout Properties of a Composition Zone, but that will
affect all the places it is used. So if you want to resize only one instance of a Composition
Zone, you need to unsynchronize it.

Also, you can’t delete a layout that is being shared. If you want to delete a shared layout,
you can turn off sharing by selecting Advanced Layout Properties from the Layout menu
and disabling the Share Layout checkbox, and sometimes you even have to close and
reopen the project before you can delete the layout.

JOB JACKETS

Murphy’s Law states that whatever can go wrong, will go wrong, which leads me to believe
that Murphy worked in prepress.

The world of design, printing, and publishing is full of opportunities for costly errors
resulting from miscommunications and mistakes that can make you miss a deadline, go
over budget, or both. Prepress specialists frequently have to deal with ambiguous project
specifications, and the cost of an error in a large print job can be significant.

Many workflows include some sort of project tracking system, which could be a simple
folder with written instructions or a complex workflow and content management system.
Without some kind of system in place, crucial information about a project is likely to get
lost on a Post-it note or in an email archive.

In XPress 7, Job Jackets are introduced to address this problem. A Job Jacket is similar to
an electronic version of a folder containing all the information required to successfully
manage a complex print project from creation through to output and beyond. You can use
Job Jackets to create projects and layouts from detailed production specifications, verify
that a layout follows its specifications, and then share your specifications with other mem-
bers of your workgroup.

When it’s time to output the job, using Job Jackets can help you minimize production
errors by evaluating your layout according to the specifications you’ve defined and helping
you track down problems. Some people liken Job Jackets to preflight software, but I think
of it more like pre-preflight, or like the Quality Assurance feature: You’ll still likely want
to use preflighting software downstream, but this is a great way to identify potential prob-
lems early in the workflow and fix them.
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